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1 Introduction

1.1 About this Manual

This reference manual provides a complete description of the SEED-Layout interface
the operations users may trigger through the interface. Readers are assumed
somewhat familiar with SEED-Layout and the concepts on which it is based. They sh
specifically understand the following concepts, which are fundamental for the wa
which SEED-Layout structures a layout task:

Layout Problem  and its components
Context
Functional Unit  and Functional Unitconstituents

Layout  and its components
Design Unit
Wall

SEED-LayoutDesign Space.

These terms are capitalized in this manual even if strictly speaking, they are not na
Consult theSEED - Fundamental Concepts manual for an introduction to these concepts

This manual, then, is not a tutorial. It is meant to serve as reference for users wh
working with SEED-Layout and want find out from where a certain command can
triggered or how a certain operation works. The individual entries are therefore shor
largely self-contained, and we tried to avoid cross-references whenever this did not r
in the repetition of large chunks of text and figures.

This manual groups descriptions of the individual features of the interface according t
windows to which the features belong. For example, the commands or items availab
the File menu of the Design Window can be found in the Design Window section and
Menu subsection. Thus, features that are near each other in the interface are descr
the same section or subsection. This also results in somewhat thematic or func
groupings as the individual windows group features by-and-large according to sh
functionalities.

Readers who are not helped by this grouping because they do not remember exactly
where a command can be triggered or where a certain functionality resides are refer
the index. They may also consult the next section, which gives an overview of
functionality of SEED-Layout in terms of the individual tasks it supports and indicate
each case where the present manual describes the respective operation.

1.2 Technical Note

SEED-Layout is based on an object-oriented design. It is written in C++ under the E
application framework. Users need not be aware of this at all. But those users wh
familiar with object-oriented design may find the following remarks useful because t
may allow these users to develop a deeper understanding of how SEED-Layout wor
to develop a more effective ‘mental model’ of its operations.
1
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Objects have states, which are represented by instance variables or attributes. The a
taken or operations executed by an object-oriented program create or delete obje
change the state of existing objects by changing some of their attributes. Many of the
commands available in SEED-Layout (such as Open a Functional Unit) display objec
specific states. If one abstracts from the graphics of the display, the screen image c
close to what is actually stored internally.

Attributes with simple values, like numbers or character strings, can be overwritten in
interface (subject to some limitations); in this case, the user affects directly a state ch
of the object involved in the operation.

But the objects SEED-Layout creates are normally not independent; they are in the
majority of cases complex configurations or compositions of linked objects, where
links are represented as relational attributes. Changing these attributes change
underlying configuration and may trigger updates and notifications of other objects.
for this reason that users of SEED-Layout have fewer opportunities to change relat
attributes directly. When they are allowed to do this, SEED-Layout provides additio
support by following up with the needed updates. But since SEED-layout intend
encourage design exploration, it retains configuration states before they were mod
When it changes the state of a relational attribute, it does not modify the exis
configuration; rather, it makes a copy of it and adjusts the relationsin the copyas required
by the action. The old configuration remains available and can be revisited, unless the
explicitly deletes it. Knowing this, users will be able to predict when an action cau
SEED-Layout to create copies of object configurations or when it changes the state
existing object.

An exception from this rule is made only when it would result in an obvious overkill; the
exceptions are identified in the present manual in the context of the action where
apply.
2
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This section gives a brief overview of the individual tasks supported by SEED-Layou
indicates in each case the section in the present manual that describes the interface
from where a task can be executed. Note that in many cases, the same action c
triggered in multiple ways.
3

Layout Problem Operations

Display windows:

• Active Layout Problem (Section 3.4.1 on page 10,
Section 5 on page 27)

• Constituent hierarchy (Section 3.4.2 on page 10,
Section 8 on page 43)

• Layout Problem manager (Section 3.4.5 on page 11,
Section 7 on page 42)

Creation/activation:

• Create an initial Layout Problem (Section 5.1 on page
28)

• Create a new Layout Problem (Section 3.6.1 on page
14)

• Open a saved Layout Problem (Section 3.1.1 on page
6)

• Revisit or activate a Layout Problem (Section 3.6.2 on
page 14, Section 3.6.2 on page 14, Section 3.6.6 on
page 16, Section 3.6.7 on page 16, Section 3.6.8 on
page 16)

View parts of a Layout Problem:

• Context (Section 5.4 on page 31, Section 5.7 on page
33)

• Top Functional Unit (Section 5.4 on page 31,
Section 5.9 on page 36)

• Required relations(Section 5.4 on page 31,
Section 5.8 on page 34)

Editing/modifying a Layout Problem:

• Add Functional Unit constituent (Section 5.3.1 on
page 29, Section 5.3.3 on page 29, Section 5.6.1 on
page 31, Section 6.2.1 on page 39, Section 6.2.2 on
page 39, Section 8.1.2 on page 44, Section 8.1.3 on
page 44)

• Share a constituent as a vertical zone (Section 5.3.5
on page 30, Section 6.2.3 on page 40)

• Edit attributes of a Functional Unit (Section 6 on page
38, Section 8.1 on page 43)

• Aggregate/disaggregate constituents: this operation is
currently not directly supported; it can be done indi-
rectly by aggregating/disaggregationg Design Units
(Section 3.6.3 on page 14, Section 3.6.4 on page 15)

Save in files:

• Save active Layout Problem (Section 3.1.2 on page 6,
Section 5.2.1 on page 28)

• Save a copy of the active Layout Problem under a dif-
ferent name - save as (Section 3.1.3 on page 6,
Section 5.2.2 on page 28)

• Save Functional Unit in the Functional Unit library
(Section 6.1.1 on page 38)

• Set input/output units for saved document file in .html
format (Section 3.2.3 on page 9)

Layout Operations

Display options in Design Window:

• Access paths (Section 3.3.1 on page 9)

• Superlayout (Section 3.3.2 on page 9, Section 3.5.5
on page 13)

• Zoom in (Section 3.3.4 on page 10, Section 3.11 on
page 22)

• Zoom out (Section 3.3.3 on page 10, Section 3.11 on
page 22)

• Actual size/adjust scale (Section 3.3.5 on page 10,
Section 3.11 on page 22)

Display windows:

• Display Layout Tree (Section 3.4.3 on page 10,
Section 9 on page 46)

• Evaluation results (Section 3.4.4 on page 11,
Section 10 on page 48)
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Open file:

• Open a saved Layout (Section 3.1.4 on page 7

Layout generation/modification:

• Add a Design Unit under user control (Section 3.5.1
on page 11, Section 3.9.1 on page 17)

• Change order of allocation (Section 3.13 on page 23)

• Generate child/sibling layout (Section 3.5.3 on page
12, Section 3.10 on page 22)

• Remove a Design Unit (Section 3.5.2 on page 12,
Section 3.9.2 on page 18)

• Edit the dimensional attributes of a Design Unit
(Section 3.2.1 on page 8, Section 3.9.3 on page 18)

• Change the function of a Design Unit (Section 3.2.2
on page 8, Section 3.9.4 on page 18)

• Expand a Design Unit (Section 3.5.4 on page 13,
Section 3.9.7 on page 20)

• Aggregate Design Units (Section 3.6.3 on page 14,
Section 3.9.5 on page 19)

• Disaggregate a Design Unit (Section 3.6.4 on page
15, Section 3.9.6 on page 20)

• Finalize the active Layout (Section 3.9.9 on page 21)

• Delete the active Layout (Section 3.5.7 on page 13,
Section 3.9.8 on page 21)

Navigation/activation:

• Goto parent/sibling/child Layout (Section 3.5.6 on
page 13, Section 3.12 on page 23)

• Goto any Layout in layout Tree (Section 9 on page
46)

Save in files:

• Set input/output/grid units for saved layout files
(Section 3.2.3 on page 9)

• Save the active Layout (Section 3.1.5 on page 7)

• Save an MDS file (Section 3.1.5 on page 7)

• Save a 3D configuration (Section 3.1.7 on page 7)
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3 Design Window

The Design Window is the primary window in SEED-Layout. It is the equivalent of wh
is called the “Document Window” in other applications. We do not use this name bec
strictly speaking, users of SEED-Layout do not produce “documents” like drawings
reports. They generate design representations inside the computer that can be u
various ways. The graphics in the Design Window only serve to display this informa
in a convenient form.

FIGURE 1. Design Window

Figure 1 shows the main components of a Design Window:

• The centraldisplay area shows the Layout that is currently active.

• Themenu bar contains pull-down menus containing sub-menus, items or options

• Thecommand bar contains two rows of command buttons that allow the user to 
ger the execution of specific design tasks.

• Generationbuttons at the right end of the command bar trigger the addition of des
units in a more automated mode.

• View control buttons allow users to zoom in or out or change the display scale.

• Navigationbuttons allow the user to activate Layouts that have been generated be
and can easily be “reached” from the active Layout.

• Theunplaced units menu can be used to change the order in which design units
generated.

menu bar

command bar

navigation buttons

view control buttons

evaluation
summary bar
message bar

unplaced
units
button

display area

generation
buttons
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• Thetestsummarybar displays a summary of the last evaluation of the active Layo
number of requirements failed; number of requirements satisfied; and number o
requirements that cannot be evaluated because of insufficient information.

• Themessage bar displays system messages.

The following sections explain the functionality of these parts in greater detail.

3.1 File Menu

3.1.1 Load Problem ...

This command loads an existing Layout Problem from a file into memory and makes i
active problem.

Steps:
1. Select the Load Problem... option from the File menu. If a Layout Problem is currently active

and has been modified, you are prompted to save or ignore the modifications made to this
problem.

2. SEED-Layout opens a file dialog box displaying the available Layout Problems in the default
directory. You may navigate through the directories to open another one.

3. From the file dialog box, select the desired problem and click Open. This closes the file
dialog box. If you requested the modifications of the active Layout Problem to be saved in
step 1, SEED-Layout saves the active problem and closes it. SEED-Layout loads the
selected problem, activates it and displays an initial Layout containing a Design Unit that
allocates the first Constituent of the top Functional Unit in the problem.

3.1.2 Save Problem

This command saves the active Layout (sub)Problem in the file from where it was re

Caution: The top Functional Unit of the active Layout Problem will be the top Functio
Unit overall in the saved problem, and the current Context will be the Context ove
independent of where the active problem resides in the current problem hierarchy. Th
if the user is currently working on a subproblem, everything higher-up will be lost.
avoid this problem, back up to the highest level Layout Problem before saving it.

3.1.3 Save Problem As ...

This command saves the active Layout Problem as an independent Layout Problem
is, the top Functional Unit of the active problem will be the top Functional Unit overall
the saved problem, and the current Context will be the Context overall independe
where the active problem resides in the current problem hierarchy.

Steps:
1. Select the Save Problem As ... option from the File menu. This opens a file dialog box

displaying the available problems in the default directory. You may navigate through the
directories to open another one.

2. Type name of file in which the problem should be saved in the Save problem as name field
or select a file in the display area to be overwritten.

3. Click Save to complete the action or Cancel to abort it. This closes the file dialog box.
6
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3.1.4 Open Layout ...

This command opens a saved Layout and makes it the active Layout. It deletes all
Layouts in the active Design Space.

Steps:
1. Select the Open Layout ... option from the File menu. This opens a file dialog box displaying

the available Layouts in the default directory. You may navigate through the directories to
open another one.

2. From the file dialog window, select the desired Layout and click Open. This closes the file
dialog box.

3. SEED-Layout displays the opened Layout as the active Layout in the Design Window.

Note that a saved Layout saves with each design unit the name of an associated Fun
Unit, provided this association existed at the time when the Layout was saved. W
SEED-Layout opens a Layout, it associates each design unit in this Layout wi
Functional Unit in the active Layout Problem that has the same name as the saved o
the saved name cannot be found in the active Layout Problem, the respective desig
will have no associated Functional Unit. Users may associate with these design
Functional Units from the active Layout Problem by using the change Functional U
command.

3.1.5 Save Layout ...

This command saves the active Layout in a file with extension .loos, from where it ca
opened again in this or another SEED-Layout session.

Steps:
1. Select the Save Layout ... option from the File menu. This opens a file dialog box displaying

the available Layout files in the default directory. You may navigate through the directories
to open another one.

2. Type name of file in which the Layout should be saved in the Save Layout As name field or
select a file in the display field to be overwritten.

3. Click Save to complete the action or Cancel to abort it. This closes the file dialog box.

3.1.6 Save MDS File

This command saves the active Layout through all levels in the problem hierarchy i
MDS file with extension .slo.YoumustfinalizetheactiveLayoutthroughall levelsbefore
executing this command (see Section 3.9.9 on page 21).

Steps:
1. (Optional) Set the appropriate units and grid (see Section 3.2.3 on page 9).

2. Select the Save MDS File... option from the File menu. This opens a file dialog box
displaying the available Layout files in the default directory. You may navigate through the
directories to open another one.

3. Type name of file in which the Layout should be saved in the Save Layout As name field or
select a file in the display field to be overwritten.

4. Click Save to complete the action or Cancel to abort it. This closes the file dialog box.

3.1.7 Finalize+Save Layout ...

This command finalizes the active Layout at all levels and saves it in a form that allo
3-dimensional display using OpenGL.
7
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Steps:
1. Select the Finalize+Save Layout option from the File menu. This opens a file dialog box

displaying the available Layout files in the default directory. You may navigate through the
directories to open another one.

2. Type name of file in which the Layout should be saved in the Save Layout As name field and
select the .oms extension.

3. Click Save. This closes the file dialog box.

3.1.8 Quit

Selecting this option closes all SEED-Layout windows and exits SEED-Layout.

3.2 Edit Menu

This menu contains commands that change the attributes of certain objects. None
commands results in the creation of a new Layout or alters in any other way a hierarc
the current design space.

3.2.1 Edit Unit

You may use this command to change directly the dimensional attributes of a Design
in the active Layout.

Steps:
1. Select a Design Unit in the active Layout.

2. Select the Edit Unit option in the Layout menu. SEED-Layout opens the Edit Design Unit
Window (see Figure 2). Overwrite any coordinate bound you wish to change, but note that
lower bounds can onl y increase and upper bounds can onl y decrease.

3. Click COMMIT or CANCEL.

4. If you clicked COMMIT, SEED-Layout tries to resize the active Layout. If it succeeds, it
refreshes the display; otherwise, it aborts the command and displays an error message.

3.2.2 Change Function

If two Design Units have been selected, SEED-Layout tries to swap the assoc
Functional Units in the active Layout. If only one Design Unit has been selected, SE
Layout tries to replace the Functional Unit associated with this Design Unit in the ac

lower/upper bound of lower x-coordinate
lower/upper bound of upper x-coordinate
lower/upper bound of lower y-coordinate
lower/upper bound of upper y-coordinate

FIGURE 2. Edit Design Unit Window
8
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Layout with the next unplaced Functional Unit. If it succeeds, SEED-Layout resizes
active Layout.

Steps:
1. Select one Design Unit in the active Layout.

2. Select the Change Function option. If replacing the Functional Unit associated with the
selected Design Unit by the next Unplaced Unit is feasible, SEED-Layout refreshes the
display of the active Layout and puts the replaced Unit back in the Unplaced Units list (at
the end); otherwise, it aborts the operation and displays an error message.

or
1. Select two Design Units in the active Layout.

2. Select the Change Function option in the Layout menu. If swapping the Functional Units is
feasible, SEED-Layout refreshes the display of the active Layout; otherwise, it aborts the
operation and displays an error message.

Note thatthis commend does not result in a new active Layout.

3.3 View Menu

3.3.1 Access Paths

This is a toggle button that turns the display of access paths in the Design Window o
off (see Figure 1 for an example of access path displays).

3.3.2 Superlayout

This is a toggle button that turns the display of superlayouts in the Design Window o
off. The superlayout is the Layout of which the active Layout is a sublayout.

In the current implementation, superlayouts are displayed only for the next higher
with respect to the active Layout; Figure 4 shows an example. Note that be
finalization, sublayouts usually do not fit exactly into their superlayouts.

FIGURE 3. Grid/Units Window

Use this option to set

• the project unit used in the current Layout Problem in the Project Unit pop-up me

• the unit to be used in the next MDS file in the Output Unit pop-up menu.

• the snap grid to be used in the next MDS file in the Grid Size field. The size of th
basic grid unit must be expressed in integer multiples of the output unit.
Example: If the output unit ismm and the snap grid should have 30cm intervals, set
output unit tomm and grid size to 300.

3.2.3 Grid/Units
9
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3.3.3 Zoom Out

This option reduces the magnification of the display in the Design Window by a facto
approximately .83 (1/1.20).

3.3.4 Zoom In

This option increases the magnification of the display in the Design Window by 20% o
a factor of 1.20.

3.3.5 Actual Size

This option rescales the display in the Design Window to the original size.

3.4 Window Menu

This menu contains options to open supplementary windows.

3.4.1 Layout Problem

Use this option to open the Layout Problem Window, which allows you to inspect and
the settings in the active Layout Problem; see Section 5 on page 27 for details.

3.4.2 Constituent Hierarchy

Use this option to open the Constituent Hierarchy Window, which displays
Constituents of the top Functional Unit of the active Layout Problem down through
entire structure; see Section 8 on page 43 for details.

3.4.3 Layout Tree

Use this option to open the Layout Tree Window, which displays the parent-child relat
between all Layouts generated so far for the active Layout Problem; see Section 9 on
46 for details.

FIGURE 4. SuperLayout display - example

active Layout
10
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3.4.4 Evaluation Result

Use this option to open the Evaluation Result Window, which displays deta
evaluations of the Layouts displayed in the Design Window; see Section 10 for a det
description.

3.4.5 Layout Problem Manager

Use this option to open the Layout Problem Manager, a window that displays
problems, subproblems and problem versions generated so far. The window can be u
reactivate any one of the problems; see Section 7 on page 42 for details.

3.5 Layout Menu

The Layout menu contains the commands that ask SEED-Layout to create Layouts
existing ones. It also contains commands to reactivate the Layouts generated so far f
active Layout Problem.

3.5.1 Add Unit

Use this command when you know exactly where the next Functional Unit should
allocated in relation to the existing Walls and Design Units in the active Layout. We
this operation also “allocation or placement under designer control.”

Steps:
1. Select a Wall in the active Layout and one or two Design Units adjacent to that Wall.

2. (Optional) Change the next Functional Unit to be placed.

3. Select the Add Unit option from the Layout menu. If not enough elements are selected, if the
selected Design Units do not border the selected Wall, or if the planned insertion is
topologically impossible, SEED-Layout displays an error message and aborts the
operation.

4. SEED-Layout allocates the selected Functional Unit in an area created by moving the
selected Design Unit(s) away from the selected Wall. If this placement is not feasible, an
error message is displayed (in rare cases, the entire operation is aborted). The new Layout
becomes the active Layout and is displayed in the Design Window.

Note that SEED-Layout allocates the Functional Unit in a copy of the active Layout
makes this copy the new active Layout. That is, the former active Layout is not destr
and can be revisited. As a general principle, the system implements a requested cha
the active Layout in acopy of that Layout whenever the change implies a structu
change.

a b

FIGURE 5. a) a Layout with a selected Wall and two selected Design Units at opposite sides;
b) the result of adding a new Design Unit with this selection
11
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The results of this operation vary significantly if two Design Units are adjacent to
selected Wall from the same or opposing sides. In the first case, the operatio
straightforward: the Design Units appear to get “pushed away” from the Wall so that
new Design Unit can be inserted in the area created in this way. If the Design Units bo
the Wall from opposite sides, SEED-Layout splits the Wall and creates a “pinwheel
“spiral” configuration (see Figure 5 for an example). This can be quite unexpected
some cases, SEED-Layout generates two new Layout s, one with a clockwise turnin
one with a counter-clockwise turning pinwheel.

3.5.2 Remove Unit

This command causes SEED-Layout to remove a Design Unit from the active Layou
to make the associated Functional Unit available for reallocation.

Steps:
1. Select a Design Unit in the active Layout.

2. Select the Remove Unit option from the Layout menu. If the Design Unit is a pinwheel,
SEED-Layout prompts you for further information to remove ambiguities:

• horizontal: collapse the pinwheel into a horizontal Wall

• vertical: collapse the pinwheel into a vertical Wall

• generate: determine which possibility is feasible and generate the first feasible possibility.

3. If the removal is feasible, SEED-Layout removes the selected Design Unit and puts the
associated Functional Unit back on the Unplaced Units list. The new Layout becomes the
active Layout and is displayed in the Design Window.

Note that SEED-Layout removes the selected Design Unit in a copy of the active La
and makes the copy the new active Layout. That is, the former active Layout is
destroyed and can be revisited.

3.5.3 Generate ...

This item opens a submenu offering two options:

• Child state : Selecting this option makes SEED-Layout attempt to generate the n
feasible child Layout of the active Layout. If such a Layout is found, it becomes t
active Layout and is displayed in the Design Window. Otherwise, SEED-Layout
aborts the operation and displays an error message.

• Sibling state : Selecting this option makes SEED-Layout attempt to generate the n
feasible sibling Layout of the active Layout, that is, the next child of the active La
out’s parent Layout. If such a Layout is found, it becomes the active Layout and 
displayed in the Design Window. Otherwise, SEED-Layout aborts the operation 
displays an error message.

a b c

FIGURE 6. Removing the corridor in (a) with option ‘vertical’ (b) or ‘horizontal’ (c)
12
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3.5.4 Expand Unit

Use this option to expand a Design Unit, that is, to create a subproblem to allocat
Constituents of the Functional Unit associated with the Design Unit inside its bounda

Steps:
1. Select a Design Unit.

2. Select the Expand Unit option in the Generation menu. If the selected Design Unit has been
expanded before, SEED-Layout displays an error message and aborts the operation.

3. SEED-Layout creates a subproblem and activates it. Its top Functional Unit is the
Functional Unit associated with the Design Unit selected in step 1. Its Context is the
boundary of that Design Unit. The initial Layout in the corresponding subspace is a Layout
allocating the first Constituent of the top Functional Unit. It is displayed in the Design
Window.

Note that if you return to the superproblem and generate child Layouts of the La
whose Design Unit was expanded, the subspace will be a subspace of this Design U
all child Layouts containing this Design Unit (the Design Unit may disappear from a c
Layout because the user may have deleted it with the Remove Unit command).

3.5.5 Display ...

This option opens a submenu offering two options:

• Sublayout : This option is currently not implemented.

• Superlayout : Selecting this option makes SEED-Layout display the superlayout o
the active Layout, if it exists. If the active Layout Problem is at the root of the Layo
Problem hierarchy, no superlayout can exist, and SEED-Layout displays an erro
message.

3.5.6 Goto ...

This option opens a submenu offering the following options to reactivate Layouts “n
the active Layout:

• Parent State : This option reactivates the Layout from which the active Layout wa
generated, if it exists.

• Previous Sibling State : This option reactivates the last sibling Layout generated
before the active Layout was generated, if it exists.

• Next Sibling State : This option reactivates the first sibling Layout generated after t
active Layout was generated, if it exists.

• Child State : This option reactivates the first child Layout of the active Layout.

Attempts to reactivate a non-existing Layout result in error messages. Note that
commands do notgenerate Layouts.

3.5.7 Delete Layout

Selecting this option triggers the deletion of the active Layout and all Layouts gener
from it. Use this option if you want to make more memory available by deleting Layo
that are no longer of interest to you.

Steps:
1. Select the Delete State option in the Layout menu.
13
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2. SEED-Layout deletes the active state and all Layouts generated from it. It makes the parent
of the active Layout the active Layout and refreshes the Design Window.

3.6 Problem Menu

This menu allows you to create a new or initial overall Layout Problem ‘on-the-fly’ and
revisit Layout Problems that were created before in the current Design Space.

3.6.1 New

This command closes the currently loaded Layout problem and creates a new one
disabled if no active Layout problem exists.

Steps:
Select the New option from the File menu. If the currently loaded Layout Problem has been
modified, you are prompted to save or ignore the modifications made to the problem. The
system closes the current problem, then opens a new Design Window.

Caution: The new Layout Problem is empty and does not have necessary informati
constitute a valid problem when it is first created. If you save the empty problem, it ca
be reloaded. You should always open the Layout Problem window and use comman
that window to input/edit the content of this new Layout Problem before saving it (
Section 5 on page 27).

3.6.2 Activate Problem

Use this option to activate an initial Layout Problem that you created from scratch
Section 5.1 on page 28). This option is disabled if an active Layout problem exists.

If you wish to replace the currently loaded Layout Problem with a new one created f
scratch, use the New option (see Section 3.6.1 on page 14).

3.6.3 Aggregate

This command can be used to aggregate selected Design Units in the active Layout
single Design Unit. As a side effect of this operation, SEED-Layout creates a varian
the active Layout Problem with a Constituent hierarchy consistent with the aggregati

Steps:
1. Select four Walls forming a rectangle in the active Layout. Make sure that the selected Walls

enclose more than one Design Unit, but not the entire Layout.

2. Select the Aggregate option from the Layout menu. If the Walls are not properly formed,
SEED-Layout displays an error message and aborts the operation.

3. SEED-Layout prompts you for the name and class of a new Functional Unit.

4. SEED-Layout creates a variant of the active Layout Problem and a variant Design Space.
The initial Layout in this space is the aggregated Layout, in which the Design Units inside
the selected rectangle are replaced by a single Design Unit associated with the Functional
Unit created in step 2. This Layout is the new active Layout and displayed in the Design
Window.

In executing this command, SEED-Layout performs a complex sequence of operatio
the background:
14
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1. Call the top Functional Unit of the active LayoutA. SEED-Layout creates a variant of
the active Layout Problem and a copy ofA. Call this copyB. SEED-Layout makesB
the top Functional Unit of the Layout Problem variant. The Constituents ofB are the
Constituents ofA except for the Functional Units associated with the Design Units
inside the selected rectangle; these units are replaced by the Functional Unit crea
step 2; call this UnitN. The replaced Functional Units become the Constituents ofN
(see Figure 7).

2. SEED-Layout creates a copy of the active Layout and replaces the Design Units in
the selected rectangle with a single, new Design Unit; call this Design Unitd. It
becomes associated with N. The new Layout becomes the first and active Layout in 
new Design Space

3. SEED-Layout creates a subspace of the new Design Space and an associated L
Problem whose top Functional Unit isN and whose Context is given by the geometry
of d. The first and active Layout in this subspace is the Layout of Design Units ins
the initially selected rectangle.

Note that the original Layout Problem and Design Space remain available and ca
revisited.

3.6.4 Disaggregate

This command can be used to disaggregate a Design Unit in the active Layout int
Design Units of a sublayout inside this Design Unit. As a side effect of this operat
SEED-Layout creates a variant of the active Layout Problem with a Constituent hiera
consistent with the disaggregation.

Steps:
1. Select a Design Unit in the active Layout that has been expanded before.

2. Select the Disaggregate option from the Layout menu. If the selected Design Unit has not
been expanded before, SEED-Layout displays an error message and aborts the operation.

3. SEED-Layout creates a variant of the active Layout Problem and a variant Design Space
whose initial Layout is the disaggregated Layout, in which the Design Units inside the
selected Design Unit replace this Design Unit. This new Layout becomes the active Layout
and is displayed in the Design Window.

In executing this command, SEED-Layout performs a complex sequence of operatio
the background:

A

C D E F G

Old Constituent hierarchy

aggregated Units

B

C

D

E

F G

New Constituent hierarchy

new Functional Unit

N

FIGURE 7. Functional Unit aggregation - example
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1. Call the top Functional Unit in the active Layout ProblemA and the Functional Unit
associated with the selected Design UnitF. SEED-Layout creates a variant of the
active Layout Problem and a copy ofA; call this copyB. B becomes the top unit in the
variant Layout Problem. It has the same Constituents asA except forF, which is
replaced by its Constituents. The variant Layout Problem becomes the active one

2. SEED-Layout creates a copy of the active Layout and replaces the selected Desi
Unit with the sublayout of Design Units that are the active Layout in the associate
subspace; this Layout becomes the first and active Layout in a new Design Spac

Note that the original Layout Problem and Design Space remain available and ca
revisited.

3.6.5 Goto Superproblem

Use this option to reactivate the Layout Problem one level up in the hierarchy. SE
Layout displays an error message if this Layout Problem does not exist. Otherwis
makes the last active Layout in the associated Design Space the active Layout and di
it in the Design Window.

3.6.6 Goto Subproblem

Use this option to reactivate the first Layout Problem one level down in the hierar
SEED-Layout displays an error message if this Layout Problem does not exist. Other
it makes the last active Layout in the associated Design Space the active Layou
displays it in the Design Window.

3.6.7 Goto Last Problem

Use this option to reactivate the last Layout Problem created before the active La
Problem at the same level in the hierarchy. SEED-Layout displays an error message
Layout Problem does not exist. Otherwise, it makes the last active Layout in the assoc
Design Space the active Layout and displays it in the Design Window.

3.6.8 Goto Next Problem

Use this option to reactivate the first Layout Problem created after the active La
Problem at the same level in the hierarchy. SEED-Layout displays an error message
Layout Problem does not exist. Otherwise, it makes the last active Layout in the assoc
Design Space the active Layout and displays it in the Design Window.

3.6.9 Save Document File

Use this option to write an .html file describing the active Layout Problem.

Steps:
1. Select the Save Document File option in the Problem menu of the Design Window. This

opens a file dialog box.

2. Enter or select the name of the file. Do not add the .html extension.

3. Click Save.
16
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3.7 Evaluation Menu

This menu will eventually allow users to trigger compute-intensive evaluations
evaluations requiring external software that are not done automatically after
generation step. No such evaluations are currently available.

The Semper option opens a window showing the “canned” results of a possible ene

evaluation performed with the Semper system currently under development at CM1.
This is only meant to give users a feel for how these evaluations may be integrated
SEED-Layout.

3.8 Help Menu

The Help menu and the two options it offers serve right now only as reminders that a
fledged production version of SEED-Layout would contain an on-line help capability.

3.9 Command Bar

This bar is intended for users who desire to customize the SEED-Layout interfac
moving frequently used commands out of the menus where they are hidden so tha
can be executed immediately. However, this customization is not available in the cu
version of SEED-Layout. The command bar of this version simply provides button
trigger directly commands that are contained as options in the Layout and Gener
menus.

3.9.1 Add Unit

This button allows you to determine exactly where the next Functional Unit is to
allocated in relation to the Design Units and Walls in the active Layout. We call t
operation also “allocation or placement under designer control.”

Steps:
1. Select a Wall in the active Layout and one or two Design Units adjacent to that Wall.

2. (Optional) Change the next Functional Unit to be placed.

3. Click the Add Unit button in the Command Bar. If not enough elements are selected, if the
selected Design Units do not border the selected Wall, or if the planned insertion is
topologically impossible, SEED-Layout displays an error message and aborts the
operation.

4. SEED-Layout allocates the selected Functional Unit in an area created by moving the
selected Design Unit(s) away from the selected Wall. If this placement is not feasible, an
error message is displayed (in rare cases, the entire operation is aborted). The new Layout
becomes the active Layout and is displayed in the Design Window.

Note that SEED-Layout allocates the Functional Unit in a copy of the active Layout
makes this copy the new active Layout. That is, the former active Layout is not destr
and can be revisited. As a general principle, the system implements a requested cha
the active Layout in acopy of that Layout whenever the change implies a structu
change.

1. Mahdavi, A.
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The results of this operation vary significantly if two Design Units are adjacent to
selected Wall from the same or opposing sides. In the first case, the operatio
straightforward: the Design Units appear to get “pushed away” from the Wall so that
new Design Unit can be inserted in the area created in this way. If the Design Units bo
the Wall from opposite sides, SEED-Layout splits the Wall and creates a “pinwheel
“spiral” configuration (see Figure 5 for an example). This can be quite unexpected
some cases, SEED-Layout generates two new Layouts, one with a clockwise-turnin
one with a counterclockwise-turning pinwheel.

3.9.2 Remove Unit

Clicking this button causes SEED-Layout to remove a Design Unit from the active Lay
and to make the associated Functional Unit available for reallocation.

Steps:
1. Select a Design Unit in the active Layout.

2. Click the Remove Unit button in the Command Bar. If the Design Unit is a pinwheel, SEED-
Layout prompts you for further information to remove ambiguities:

• horizontal: collapse the pinwheel into a horizontal Wall

• vertical: collapse the pinwheel into a vertical Wall

• generate: determine which possibility is feasible and generate the feasible possibilities.

3. If the removal is feasible, SEED-Layout removes the selected Design Unit and puts the
associated Functional Unit back on the Unplaced Units list. The new Layout becomes the
active Layout and is displayed in the Design Window.

Note that SEED-Layout removes the selected Design Unit in a copy of the active La
and makes the copy the new active Layout. That is, the former active Layout is
destroyed and can be revisited.

3.9.3 Edit Unit

You may use this button to change directly the dimensional attributes of a Design Un
the active Layout.

Steps:
1. Select a Design Unit in the active Layout.

2. Click the Edit Unit button in the Command Bar. SEED-Layout opens the Edit Design Unit
Window (Figure 2). Overwrite any coordinate bound you wish to change, but note that lower
bounds can onl y increase and upper bounds can onl y decrease.

3. Click COMMIT or CANCEL.

4. If you clicked COMMIT, SEED-Layout tries to resize the active Layout. If it succeeds, it
refreshes the display; otherwise, it aborts the command and displays an error message.

3.9.4 Change Function

If two Design Units have been selected, SEED-Layout tries to swap the assoc
Functional Units in the active Layout. If only one Design Unit has been selected, SE
Layout tries to replace the Functional Unit associated with this Design Unit in the ac
Layout with the next unplaced Functional Unit. If it succeeds, SEED-Layout resizes
active Layout.

Steps:
1. Select one Design Unit in the active Layout.
18
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2. Click the Change Function button in the Command Bar. If replacing the associated
Functional Unit with the next unplaced Unit is feasible, SEED-Layout refreshes the display
of the active Layout and puts the replaced Unit back in the Unplaced Units list (at the end);
otherwise, it aborts the operation and displays an error message.

or
1. Select two Design Units in the active Layout.

2. Click the Change Function button in the Command Bar. If swapping the associated
Functional Units is feasible, SEED-Layout refreshes the display of the active Layout;
otherwise, it aborts the operation and displays an error message.

Note that this commend does not result in a new active Layout.

3.9.5 Aggregate

This button can be used to aggregate selected Design Units in the active Layout i
single unit. As a side effect of this operation, SEED-Layout creates a variant of the a
Layout Problem with a Constituent hierarchy consistent with the aggregation.

Steps:
1. Select four Walls forming a rectangle in the active Layout. Make sure that the selected Walls

enclose more than one Design Unit, but not the entire Layout.

2. Click the Aggregate button in the Command Bar. If the selected Walls are not properly
formed, SEED-Layout displays an error message and aborts the operation.

3. SEED-Layout prompts you for the name and class of a new Functional Unit.

4. SEED-Layout creates a variant of the active Layout Problem and a variant Design Space.
The initial Layout in this space is the aggregated Layout, in which the Design Units inside
the selected rectangle are replaced by a single Design Unit associated with the Functional
Unit created in step 2. This Layout is the new active Layout and displayed in the Design
Window.

In executing this command, SEED-Layout performs a complex sequence of operatio
the background:

1. Call the top Functional Unit of the active LayoutA. SEED-Layout creates a variant of
the active Layout Problem and a copy ofA. Call this copyB. SEED-Layout makesB
the top Functional Unit of the Layout Problem variant. The Constituents ofB are the
Constituents ofA except for the Functional Units associated with the Design Units
inside the selected rectangle; these units are replaced by the Functional Unit crea
step 2; call this UnitN. The replaced Functional Units become the Constituents ofN
(see Figure 7).

2. SEED-Layout creates a copy of the active Layout and replaces the Design Units in
the selected rectangle with a single, new Design Unit; call this Design Unitd. It
becomes associated withN. The new Layout becomes the first and active state in a n
Design Space

3. SEED-Layout creates a subspace of the new Design Space and an associated L
Problem whose top Functional Unit isN and whose Context is given by the geometry
of d. The first and active Layout in this subspace is the Layout of Design Units ins
the initially selected rectangle.

Note that the original Layout Problem and Design Space remain available and ca
revisited.
19
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3.9.6 Disaggregate

This button can be used to disaggregate a Design Unit in the active layout into the D
Units of a sublayout inside this Design Unit. As a side effect of this operation, SEE
Layout creates a variant of the active Layout Problem with a Constituent hiera
consistent with the disaggregation.

Steps:
1. Select a Design Unit in the active Layout that has been expanded before.

2. Click the Disaggregate button in the Command Bar. If the selected Design Unit has not been
expanded before, SEED-Layout displays an error message and aborts the operation.

3. SEED-Layout creates a variant of the active Layout Problem and a variant Design Space
whose initial Layout is the disaggregated Layout, in which the Design Units inside the
selected Design Unit replace this Design Unit. This new Layout becomes the active Layout
and is displayed in the Design Window.

In executing this command, SEED-Layout performs a complex sequence of operatio
the background:

1. Call the top Functional Unit in the active Layout ProblemA and the Functional Unit
associated with the selected Design UnitF. SEED-Layout creates a variant of the
active Layout Problem and a copy ofA; call this copyB. B becomes the top unit in the
variant Layout Problem. It has the same Constituents asA except forF, which is
replaced by its Constituents. The variant Layout Problem becomes the active one

2. SEED-Layout creates a copy of the active Layout and replaces the selected Desi
Unit with the subLayout of Design Units that are the active Layout in the associat
subspace; this Layout becomes the first and active Layout in a new Design Spac

Note that the original Layout Problem and Design Space remain available and ca
revisited.

3.9.7 Expand Unit

Use this button to “expand” a Design Unit, that is, to create a subproblem to allocate
Constituents of the Functional Unit associated with the Design Unit inside its bounda

Steps:
1. Select a Design Unit.

2. Click the Expand Unit button in the Command Bar. If the selected Design Unit has been
expanded before, SEED-Layout displays an error message and aborts the operation.

3. SEED-Layout creates a subproblem and activates it. Its top Functional Unit is the
Functional Unit associated with the Design Unit selected in step 1. Its Context is the
boundary of that Design Unit. The initial Layout in the corresponding subspace is a Layout
allocating the first Constituent of the top Functional Unit. It is displayed in the Design
Window.

Note that if you return to the superproblem and generate child Layouts of the La
whose Design Unit was expanded, the subspace will be a subspace of this Design U
all child Layouts containing this Design Unit (the Design Unit may disappear from a c
Layout because you may have deleted it with the Remove Unit command).
20
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3.9.8 Delete State

Clicking this button triggers the deletion of the active Layout and all Layouts genera
from it. Use this option if you want to make more memory available by deleting Layo
that no longer interest you.

Steps:
1. Click the Delete State button in the Command Bar.

2. SEED-Layout deletes the active state and all Layouts generated from it. It makes the parent
of the active Layout the active Layout and refreshes the Design Window.

3.9.9 Finalize State

You may use this button to “finalize” the active Layout, that is, to create a Layout w
fixed dimensions. This may be needed to supply input to other applications or S
modules. Specifically,you must trigger this command before generating an MDS-file.

Steps:
1. Click the Finalize State button in the Command Bar. SEED-Layout opens the Finalize dialog

box.

2. Select one of the options offered:
• Yes: Layouts will be finalized throughout the problem hierarchy. SEED-Layout picks the last

active Layout in each subspace and coordinates them so that they fit together, if this is
possible at all.

• No: SEED-Layout finalizes only the active Layout.

• Cancel: Abort operation.

3. SEED-Layout creates the finalized Layout (s) and updates the Design Window.

If you selected the Yes option in step 2, SEED-Layout performs a complex sequen
operations in the background.

1. It visits all subspaces that have created for the currently active Layout Problem a
finds the last active Layout in each subspace. This may involver finding the last a
version of the subspace if you used the aggregate or disaggregate commands at
time.

2. It creates constraints that assure that the selected sublayouts fit properly into the
boundaries of the Design Units they expand. If these constraints cannot be solve
SEED-Layout creates error messages to be displayed at the end of the operation

3. It instantiates all relational constraints whose Functional Units have been allocate
some active sub(layout) together with all constraints specified by the Functional U
allocated in each sublayout.

4. It tries to solve the resulting systems of constraints. If more than one solution exist
tries to minimize at the same time the overall area; or, if the layouts allocate mass
elements, it tries to minimize the areas occupied by the massing elements.

5. It displays in the Design Window the finalized (sub)layout at the level from where
finalize command was issued. You may visit the other finalized Layouts by naviga
through the problem hierarchy (see Section 3.6 on page 14).

Note that SEED-Layout does not finalize the active Layouts themselves, but co
thereof; that is, the non-finalized versions can be reactivated.

But note also thatthe finalized Layouts are now the active Layouts in the respective
DesignSpaces. Keep this in mind if you do not quit SEED-Layout soon, but expl
further layout options and try to finalize another layout alternative through all levels of
21
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problem hierarchy. This will not work in all likelihood if a finalized sublayout remain
active in some subspace: it now has fixed dimensions and will therefore be hard to fi
a differently dimensioned superlayout. In order to avoid this problem, you will have
revisit each subspace and make sure that the active layout in this space is the one yo
to include in the finalization. Some automated support for this process is conceivable
currently not implemented.

3.10 Generation Buttons

All children : Clicking this button makes SEED-Layout attempt to generate all feas
children of the active Layout. If no feasible child Layout exists, SEED-Layout displays
error message and aborts the operation. Otherwise, the last feasible Layout found be
the active Layout and is displayed in the Design Window. Use the Layout navigation t
to visit the other feasible Layouts. You may interrupt this operation in the interrupt dia
box that is opened as a result of this commend.

Next child : Clicking this button makes SEED-Layout attempt to generate the next feas
child Layout of the active Layout. If such a Layout is found, it becomes the active Lay
and is displayed in the Design Window. Otherwise, SEED-Layout displays an e
message and aborts the operation.

Note that if more than one Functional Unit has been selected in the Unplaced U
window, any one of these commands allocates all selected Functional Units in one s

3.11 View Control Buttons

Zoom out : Clicking this button reduces the magnification of the display in the Des
Window by a factor of approximately .83 (1/1.20).

next sibling

all children

next child

FIGURE 8. Generation buttons

The generation buttons are located at the right end of the command bar (see Figure

Next sibling : Clicking this button makes SEED-Layout attempt to generate the n
feasible sibling Layout of the active Layout, that is, the next child of the active Layo
parent Layout. If such a Layout is found, it becomes the active Layout and is displaye
the Design Window. Otherwise, SEED-Layout displays an error message and abor
operation.

adjust scale

zoom in

zoom out

FIGURE 9. View control buttons

The view control buttons are located below the left end of the command bar (
Figure 9).

Adjust scale : Clicking this button makes SEED-Layout attempt to find a mor
appropriate magnification factor for the display in the Design Window.

Zoom in : Clicking this button increases the magnification of the display in the Desi
Window by 20% or by a factor of 1.20.
22
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3.12 Layout Navigation Buttons

Parent : Clicking this button reactivates the Layout from which the active Layout w
generated, if this parent Layout exists (that is, the active Layout is not the root Layo
the active Design Space).

Last sibling : Clicking this button reactivates the last sibling Layout generated before
active Layout was generated, provided this sibling exists.

SEED-Layout displays an error message if the Layout to which you wish to return d
not exist.

3.13 Unplaced Units Dialog Box

Open the Unplaced Units dialog box from the Next Unit pop-up menu below
Generation Buttons in the Design Window. This box allows you to change the orde
which Functional Units are allocated and to select several Functional Units
simultaneous allocation (see Figure 11).

The Unplaced Units dialog box is non-modal; can be dismissed by clicking the Dism
button. The left-hand Available field displays the names of the Functional U
Constituents in the active Layout Problem that have not been allocated in the a
Layout. Move a Constituent to the top of the allocation order as follows:

Steps:
1. Select the name in the Available field and click the right-pointing arrow button. You will see

how the name pops up in the Selected field on the right.

next sibling
first child
parent
last sibling

FIGURE 10. Layout navigation
buttons

The Layout navigation buttons are located next to the view control buttons (
Figure 10).

Next sibling : Clicking this button reactivates the first sibling Layout generated after
active Layout was generated, provided this sibling exists.

First child : Clicking this button reactivates the first child Layout generated from the act
Layout, provided at least one child Layout has been generated before.

FIGURE 11. Unplaced Units dialog box
23



2. Repeat this step for multiple selections

or

Remove a selection by selecting the Functional Unit name in the Selected field and clicking
the left-pointing arrow button.

3. Click the Commit button when you are done or Cancel to undo the selections.

4. Click Dismiss to close the box.
24
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4 File Dialog Boxes

Most widgets in the file dialog box are not SEED-Layout specific; they are features p
vided by the ET++ application framework, which is used not only by SEED-Layout, b
also by SEED-Pro and the SEED development environment. The contents displayed
these widgets are therefore not necessarily relevant to SEED-Layout.

4.1 File Menu

The file menu contains the full path names of the files that were selected in any ET
based application; the files are listed in reverse order (last selected-first in list)
independently of their content.

4.2 Directories Menu

The directories menu contains the full path names of the directories that were selec
any ET++-based application; the directories are listed in reverse order andindependently
of their content. Double-clicking a name opens this directory and displays the fi
contained in it in the file selection field.

4.3 Options Menu

4.3.1 Edit files

<to be added>

FIGURE 12. Typical file dialog box

file selection field
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4.3.2 Edit directories

<to be added>

4.3.3 Hidden files

This is a toggle that controls the display of ‘hidden’ files.

4.3.4 Create directory

4.4 Display Field

Single-clicking a name in the display field selects the respective file and makes the
name appear in the name field below.

Double-clicking a name executes the command that opened the file dialog box. If this
an Open command, the selected file is opened, butonly if the file hasthe appropriate
content; for example, opening a file in a dialog box brought up as a result of the O
Layout command will succeed only if the file actually contains a saved Layout. If
command was a Save command, the selected file will be overwritten, but you
prompted explicitly to confirm this.

4.5 Other Features

The Save/Open and Cancel buttons at the bottom of the box work as expected.

4.5.1 Directory button

This is a pop-up button by means of which the path of the current directory can
traversed upwards.

4.5.2 Name field

This field can be used in Open file commands to type-in the name of the desired file. I
be used in Save commands to type-in the name under which a file is to be saved.

4.5.3 Filter field

You may type-in a pattern to be used in selecting the files that are displayed in the di
field. For example, the pattern *CLINIC* will restrict the display to files containing th
string ‘CLINIC’ in their name. In order to activate a pattern, the Update button must
clicked.

4.5.4 Update button

Clicking this button updates the file selection field using the current filter.
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5 Layout Problem Window

Figure 13 shows a snapshot of the Layout Problem Window. You open up the La
Problem Window by selecting the Layout Problem option under the Window menu in
Design Window.

The Layout Problem Window displays the attributes of the active Layout Problem
categories such as Context, Relational Constraints, the associated Functional Unit, a
Constituents. You may expand the display of each category by using, for example
arrow button in the upper right corner; Figure 13 shows this for the Context categ
Navigation buttons in the upper right-hand corner allow you to activate Layout Probl
that are ‘close’ to the one displayed in the associated problem hierarchy. A comman
shows buttons that can be selected to execute tasks needing no further specification
the designer.

FIGURE 13. Layout Problem Window

menu bar

command bar

name of Layout Problem

Context field (opened)

Required Relations field

name/class
of top Functional Unit

Occupancy field

Constituent field

Value Constraint field

navigation buttons

open/
close
buttons
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5.1 Create an Initial Layout Problem

If you open the Layout Problem Window before any Layout Problem has been open
the current SEED-Layout session, you may use the commands available from this wi
to create a new Layout Problem and to activate it. To get started, you must define

• a minimum Context (see Section 5.7 on page 33)

• a top Functional Unit (Section 5.3.1 on page 29, Section 5.3.2 on page 29)

• at least one Constituent for this unit (Section 5.3.3 on page 29, Section 5.6.1 on
31).

If you then select the Activate Problem command from the Problem menu in the De
Window, SEED-Layout creates an initial Layout that allocates the first Constituent in
defined Context and displays it in the Design Window.

5.2 File Menu

5.2.1 Save Problem

This command saves the active Layout (sub)problem in the file from where it was re

Caution: The top Functional Unit of the active Layout Problem will be the top Functio
Unit overall in the saved problem, and the current Context will be the Context ove
independent of where the active problem resides in the current problem hierarchy. Th
if the user is currently working on a subproblem, everything higher up will be lost.
avoid this problem, back up to the highest level Layout Problem before saving it.

5.2.2 Save Problem As ...

This command saves the active Layout Problem as an independent Layout Problem
is, the top Functional Unit of the active problem will be the top Functional Unit overall
the saved problem, and the current Context will be the Context overall independe
where the active problem resides in the current problem hierarchy.

Steps:
1. Select the Save Problem As ... option from the File menu. This opens a file dialog box

displaying the available problems in the default directory. You may navigate through the
directories to open another one.

2. Type the name of file in which the problem should be saved in the Save Problem As name
field or select the name of the file you want to overwrite in the display field.

3. Click Save or Cancel. This closes the file dialog box.

5.2.3 Close

This option closes the Layout Problem Window.
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5.3 Edit Menu

5.3.1 Add Top FU ...

Select this or the following option when you are creating an initial Layout Problem fr
scratch.

Steps:
1. Select the Add Top FU ... option in the Edit menu. This opens the Add Top FU dialog box.

2. Type-in the name of the top Functional Unit in the Name field.

3. Select its class in the Class pop-up menu if you want to override the default selection.

4. Select its type in the Type pop-up menu if you want to override the default selection.

5. Click COMMIT (or CANCEL to abort the operation).

6. Edit the value constraints of the top Functional Unit in the Value Constraint field of the
Layout Problem Window. You should set at the least a plausible minimum width and area
(see Section 5.9.3 on page 37).

5.3.2 Add Top FU from Library ...

Select this or the preceding option when you are creating an initial Layout Problem f
scratch.

Steps:
1. Select the Add Top FU from Library ... option in the Edit menu. This opens the FU File dialog

box. The box displays instances of all generic Functional Unit classes as well as all other
Functional Unit instances that have been saved in the library.

2. Select a desired top Functional Unit (see Section 4 on page 25).

3. Inspect and, possibly, modify the value constraints of the top Functional Unit in the Value
Constraint field of the Layout Problem Window (see Section 5.9.3 on page 37).

5.3.3 Add Constituent ...

Use this command to add a Constituent to the top Functional Unit. For every Constit
to be added, you must select aclass from the following options:

• Functional Unit (default, but not recommended)

• Storey (or Floor)

• Flat roof

• Sloped roof

• Building

• Massing element

• Horizontal zone

• Room

• Shaft

• Atrium

You must also select atype from the following options:

• variable size (default)

• fixed size.

Consult theSEED-Fundamental Concepts manual for an explanation of these options.
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Steps:
1. Select the Constituent ... option from the Add ... cascading menu in the Edit Menu. This

opens the Add Constituent dialog box (see Figure 14).

2. Enter the name into the Name field

3. Select the class of the Constituent in the Class pop-up menu if you want to override the
default selection.

4. Select the type in the Type pop-up menu if you want to override the default selection.

5. Click COMMIT to confirm the action or CANCEL to cancel.

5.3.4 Add Constituent from FU Library ...

Select this command to add a Functional Unit that has been saved before as a Cons
of the top Functional Unit.

Steps:
1. Select the Constituent from FU Library ... option from the Add ... cascading menu in the Edit

Menu. This opens the Add Constituent file dialog box that displays the currently saved
Functional Units. These include - at the minimum - an instance for each available Functional
Unit class.

2. Select a desired Functional Unit (see Section 4 on page 25).

3. Inspect and, possibly, modify the value constraints of the Functional Unit (see Section 5.9.2
on page 37).

5.3.5 Share Constituent ...

You may use this command to indicate to SEED-Layout that a Functional Unit that
VerticalZoneFU (ShaftFU or AtriumFU) should extend into a certain floor. Selecting t
command will result in an error message unless each of the following conditions is m

1. The top Functional Unit of the active Layout Problem is a StoreyFU. That is, you 
add a shared constituent only to a StoreyFU and only at the level immediately be

2. A different StoreyFU constituentin the same MassingElementFU already contains a
VerticalZoneFU. Because of 1, this VerticalZoneFU must also be a constituent at 
level immediately below that StoreyFU.

Steps:
1. Select the Share Constituent ... option from the Add ... cascading menu in the Edit Menu. If

condition 1 or 2 is not met, SEED-Layout displays an error message and aborts the
operation. Otherwise, it opens the Share Constituent dialog box.

2. The dialog box displays in its display field the names of the VerticalZoneFUs that can be
added as a constituent to the top Functional Unit. Select a name in the field.

3. Click Select to complete the operation or Cancel to abort it. If the selected Functional Unit
is already a constituent of the top Functional Unit, SEED-Layout displays an error message
and abort the operation.

FIGURE 14. Add Constituent Window
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5.3.6 Add Required Relation ...

This command allows you to add a required relation to the active Layout Problem. M
sure you understand the available relation types and their parameters by consultin
SEED- Fundamental Concepts manual if needed.

Steps:
1. Select the Required Relation ... option from the Add ... cascading menu in the Edit Menu.

This opens the Add Required Relation dialog box.

2. Select the desired relation type from the available options. If this type differs from the
default type, the dialog box may change its appearance to show different parameters.

3. Set the parameters in the parameter fields.

4. Select the Functional Units to which the relation applies. Except for alternative adjacencies,
the relation applies always to two units selected in the FU1 and FU2 fields; you must make
four selections for alternative adjacencies to indicate the two pairs of Functional Units
involved.

5. Click COMMIT (or CANCEL to abort the operation).

5.4 View Menu

The options in the View menu allow to open/close the following fields of the Layo
Problem Window:

• Context

• Occupancy

• Constituents

• Value Constraints

• Adjacencies

• Alt. Adjacencies

• Directions

• Distances

• Accessibilities

5.5 Window Menu

The Window Menu currently contains one option that allows you to open the Constit
Hierarchy Window (see Section 8 on page 43).

5.6 Command Bar

5.6.1 Add Constituent

Use this command to add a Constituent to the top Functional Unit. For every Constit
to be added, you must select aclass from the following options:

• Functional Unit (default, but not recommended)

• Storey (or Floor)

• Flat roof

• Sloped roof

• Building
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• Horizontal zone

• Room

• Shaft

• Atrium

You must also select atype from the following options:

• variable size (default)

• fixed size.

Consult theSEED-Fundamental Concepts manual for an explanation of these options.

Steps:
1. Select the Constituent ... option from the Add ... cascading menu in the Edit Menu. This

opens the Add Constituent dialog box (see Figure 14).

2. Enter the name into the Name field

3. Select the class of the Constituent in the Class pop-up menu

4. Select the type in the Type pop-up menu

5. Click COMMIT to confirm the action or CANCEL to cancel.

6. (Optional) Inspect and possibly modify the value constraints associated with this new
Constituent.

5.6.2 Add Req. Relation

This command allows you to add a required relation to the active Layout Problem. M
sure you understand the available relation types and their parameters by consultin
SEED- Fundamental Concepts manual if needed.

Steps:
1. Click the Add Required Relation ... button in the command bar of the Layout Problem

Window. This opens the Add Required Relation dialog box.

2. Select the desired relation type from the available options. If this type differs from the
default type, the dialog box may change its appearance to show different parameters.

3. Set the parameters in the parameter fields.

4. Select the Functional Units to which the relation applies. Except for alternative adjacencies,
the relation applies always to two units selected in the FU1 and FU2 fields; you must make
four selections for alternative adjacencies to indicate the two pairs of Functional Units
involved.

5. Click COMMIT (or CANCEL to abort the operation)

5.6.3 Delete Req. Relations

Steps:
1. Click the Delete Req. Relations button in the command bar of the Layout Problem Window.

This opens the Relational Constraints dialog box.

2. (Optional) If the type of relation you want to delete differs from the default type (Adjacency),
select the relation type you want to delete in the Type pop-up menu. The display field is
updated to display the currently defined relational constraints of the selected type.

3. Select the specific constraint you want to delete in the display field. You may make multiple
selections by holding down the SHIFT key.

4. Click the Remove button.

5. (Optional) repeat steps 3 and 4 if you want to delete more constraints.
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6. Click COMMIT (or CANCEL to abort the operation).

5.6.4 Navigation Buttons

Last problem : Clicking this button reactivates the last Layout Problem created before
active Layout Problem at the same level in the hierarchy. SEED-Layout displays an
message if this Layout Problem does not exist. Otherwise, it makes the last active La
in the associated Design Space the active Layout and displays it in the Design Wind

Subproblem : Clicking this button reactivates the first Layout Problem one level down
the hierarchy from the active Layout Problem. SEED-Layout displays an error messa
this Layout Problem does not exist. Otherwise, it makes the last active Layout in
associated Design Space the active Layout and displays it in the Design Window.

Next problem : Clicking this button reactivates the first Layout Problem created after
active Layout Problem at the same level in the hierarchy. SEED-Layout displays an
message if this Layout Problem does not exist. Otherwise, it makes the last active La
in the associated Design Space the active Layout and displays it in the Design Wind

5.7 Context Field

The Context field displays the current Context settings. These settings restrict the o
area available for allocating the top Functional Unit and its Constituents. The meanin
the settings is explained in the table below.

You may use the Context field to inspect and modify the Context settings. Afte
modification, click COMMIT to complete the action or CANCEL to return to the previo
settings.

super-
problem
last
problem
sub-
problem
next
problem

The navigation buttons at the right end of the command bar offer another means to trae
the problem hierarchy:

Superproblem : Clicking this button re-activates the problem one level up in the hierary
from the active Layout Problem. SEED-Layout displays an error message if this Lat
Problem does not exist. Otherwise, it makes the last active Layout in the associated Dn
Space the active Layout and displays it in the Design Window.

min max

X-Low: lower bound for low x-coordinate of
area

upper bound for low x-coordinate of
area

X-High: lower bound for high x-coordinate of
area

upper bound for high x-coordinate of
area

Y-Low: lower bound for low y-coordinate of
area

upper bound for low y-coordinate of
area

Y-High: lower bound for high y-coordinate of
area

upper bound for high y-coordinate of
area
33
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The Context settings are imported from the top Layout Problem if it is opened from a
or computed automatically for subproblems.If you aresettingup a new LayoutProblem
form scratch,you must set at least the max X-High and max Y-High values because
otherwise, SEED-Layout does not know where to limit the design area. The min X-L
and Y-low values have zero as default values. Setting a min value equal to a max
fixes the respective coordinate to a single value. You may specify an exact are
allocation by fixing all four coordinates in this fashion.

Note that the settings must be compatible with the value constraints of the top Funct
Unit. An incompatible setting occurs, for example, when the minimum width constrain
the top Functional Unit is larger than the difference between the max X_High and min
Low coordinate: this means that the width of the available area in the x-direction is
large enough to accommodate the required minimum width of the top Functional U
SEED-Layout cannot open or activate a Layout Problem with these types
incompatibilities. If you try it, the system responds with an error message.

5.8 Required Relations Field

The subfields of the Required Relations Field allow you to inspect and edit the relati
constraints currently set for the active Layout Problem. Note that these constraints a
in the top problem and passed to all subproblems independently of the Constituents
subproblem. However, when evaluating relational constraints, SEED-Layout curre
takes only those constraints into account that apply between Functional Units that are
Constituents in the active Layout Problem. An exception occurs when you reques
finalization of the active Layout through all levels. In this case, all relational constra
are instantiated, and SEED-Layout attempts to satisfy all of them.

This approach may appear puzzling at first sight, but makes sense if you think abo
Suppose the Functional Units to which a relational constraint applies are Constituen
different Functional Units, possibly at different levels in the Functional Unit hierarchy.
any time, they may or may not be allocated in a different Design Space, and if they
allocated, they may be allocated in different Layout s. SEED-Layout cannot know ag
which Layout the constraint should be evaluated; after all, you may revisit that De
Space and generate more alternatives. How could SEED-Layout know what to do in
uncertain situation? It therefore defers consideration of relational constraints betw
Functional Units at different levels in the hierarchy until you request finalization throu
all levels (see Section 3.9.9 on page 21). In this case, SEED-Layout knows which Lay
to pick in each Design Space, and it tries to satisfy every relational constraint betw
Functional Units if each of them has been allocated in an active Layout in some De
Space.

5.8.1 Adjacencies

The Adjacencies field displays the currently valid adjacency constraints. Each row in
field describes a current adjacency constraint. The first two boxes in a row display
names of the Functional Units to which the constraint applies, and the last box define
minimum overlap required.

Change a setting by overwriting the value in the respective box and by clicking
COMMIT button at the bottom of the Layout Problem Window. Click CANCEL to resto
the previous value(s).
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5.8.2 Alternative Adjacencies

The Alternative Adjacencies field displays the currently valid alternative adjace
constraints. Each constraint is described by two successive rows, each describin
alternative. The first two boxes in a row display the names of the Functional Unit
which the alternative constraint applies, and the last box defines the minimum ove
required. Figure 16 displays, for example, two alternative adjacency constraints. The
constraint specifies that the CORRIDOR has to be adjacent either to the WAITING AR
or to the VESTIBULE. SEED-Layout considers an alternative adjacency constr
satisfied if at least one alternative is satisfied.

Change a setting by overwriting the value in the respective box and by clicking
COMMIT button at the bottom of the Layout Problem Window. Click CANCEL to resto
the previous value(s).

5.8.3 Directions

The Directions field displays the currently valid direction constraints. Each constrain
described by a row. The two boxes in a row display the names of the Functional Uni
which the constraint applies. The four buttons on the right if the direction indicated by
button is desired. The first constraint in Figure 17, for example, indicates that the app
should be to the east or to the west of the dorm_wing unit. SEED-Layout conside
direction constraint satisfied if at least one alternative is satisfied.

Change a setting by overwriting the value in the respective box and by toggling the de
direction button. Click the COMMIT button at the bottom of the Layout Problem Windo
to confirm or click CANCEL to restore the previous value(s)

FIGURE 15. Required Adjacencies Field

FIGURE 16. Required Alternative Adjacencies Field
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5.8.4 Distances

The Distances field displays the currently valid distance constraints. Each row in the
describes a current distance constraint. The first two boxes in a row display the nam
the Functional Units to which the constraint applies, and the last box defines the maxi
distance allowed between the two units.

Change a setting by overwriting the value in the respective box and by clicking
COMMIT button at the bottom of the Layout Problem Window. Click CANCEL to resto
the previous value(s).

5.8.5 Accessibilities

The Accessibilities field displays the currently valid accessibility constraints. Each row
the field describes a current accessibility constraint. The first two boxes in a row dis
the names of the Functional Units to which the constraint applies, and the last box de
the minimum width to be maintained by a public path connecting the two units.

Change a setting by overwriting the value in the respective box and by clicking
COMMIT button at the bottom of the Layout Problem Window. Click CANCEL to resto
the previous value(s).

5.9 Functional Unit Field

The Functional Unit Field shows the name and class of the top Functional Unit of
active Layout Problem and contains expandable subfields displaying its attributes.

FIGURE 17. Required Directions Field

FIGURE 18. Required Accessibilities Field
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5.9.1 Occupancy

The attributes in this field are currently not used in SEED-Layout because they
important only for evaluation software or down-stream processes like structural de
that are currently not accessible from SEED-Layout.

5.9.2 Constituents

The Constituents field displays the Constituents of the top Functional Unit. It is these
that are allocated in the Layouts generated for active Layout Problem. Selecting one
and clicking the right mouse button opens a Functional Unit Window that allows you
inspect and modify the current settings of this Functional Unit (see Section 6 on pag

5.9.3 Value Constraint

This field shows the value constraints currently set for the Top Functional Unit. Note
they constrain the overall area available for the Layouts generated for the active La
Problem.

You may inspect the current settings and edit them. The following table indicates
meaning of each setting. Consult theSEED - Fundamental Conceptsmanual for a more
detailed explanation of the settings. Click the COMMIT button when you are done or
CANCEL button to return to the previous settings. See Section 6.6 on page 41 fo
explanation of the constraint settings.
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6 Functional Unit Window

A Functional Unit Window allows you to inspect and edit the settings of a specific Fu
tional Unit (see Figure 19). It is non-modal, and you may have several open at the sa
time.

6.1 File Menu

6.1.1 Save FU ...

Use this command to save the Functional Unit in the Functional Unit library.

Steps:
1. Select the Save FU ... option from the Edit menu of the Functional Unit Window. This opens

the FU File dialog box.

2. Type the name under which you want to save the Functional Unit in the Save Functional
Unit field or select the name of an existing Functional Unit in the display field.

3. Click Save to complete the action or Cancel to abort it.

6.1.2 Close

Select this option to close the window.

FIGURE 19. Functional Unit Window

menu bar

command bar

name and class

Occupancy field

Constituent field

Value constraint field

use to open/
close field
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6.2 Edit Menu

The Edit menu currently contains one pop-up button, Add, from where you may selec
following commands.

6.2.1 Add Constituent ...

Use this command to add a Constituent to the Functional Unit. For every Constituent
added, you must select aclass from the following options:

• Functional Unit (default, but not recommended)

• Storey (or Floor)

• Flat roof

• Sloped roof

• Building

• Massing element

• Horizontal zone

• Room

• Shaft

• Atrium

You must also select atype from the following options:

• variable size (default)

• fixed size.

Consult theSEED-Fundamental Concepts manual for an explanation of these options.

Steps:
1. Select the Constituent ... option from the Add ... cascading menu in the Edit Menu. This

opens the Add Constituent dialog box (see Figure 14).

2. Enter the name into the Name field.

3. Select the class of the Constituent in the Class pop-up menu.

4. Select the type in the Type pop-up menu.

5. Click COMMIT to confirm the action or CANCEL to cancel.

6. (Optional) Inspect and possibly modify the value constraints associated with this new
Constituent (see Section 6.5 on page 41).

6.2.2 Add Constituent from FU Library ...

Select this command to add a Constituent to the Functional Unit that has been s
before.

Steps:
1. Select the Constituent from FU Library ... option from the Add ... cascading menu in the Edit

Menu. This opens the Add Constituent file dialog box that displays the currently saved
Functional Units. These include - at the minimum - an instance for each available Functional
Unit class.

2. Select a desired Functional Unit (see Section 4 on page 25).

3. (Optional) Inspect and possibly modify the value constraints associated with this new
Constituent (see Section 6.5 on page 41).
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Inspect and, possibly, modify the value constraints of the Functional Unit (see Section 5.9.2 on
page 37).

6.2.3 Share Constituent ...

You may use this command to indicate to SEED-Layout that a Functional Unit that
VerticalZoneFU (ShaftFU or AtriumFU) should extend into a certain floor. Selecting t
command will result in an error message unless each of the following conditions is m

1. The Functional Unit displayed in the Functional Unit Window is a StoreyFU. That 
you can add a shared constituent only to a StoreyFU and only at the level immedia
below.

2. A different StoreyFU constituentin the same MassingElementFU already contains a
VerticalZoneFU. Because of 1, this VerticalZoneFU must also be a constituent at 
level immediately below that StoreyFU.

Steps:
1. Select the Share Constituent ... option from the Add ... cascading menu in the Edit Menu. If

condition 1 or 2 is not met, SEED-Layout displays an error message and aborts the
operation. Otherwise, it opens the Share Constituent dialog box.

2. The dialog box displays in its display field the names of the VerticalZoneFUs that can be
added as a constituent to the top Functional Unit. Select a name in the field.

3. Click Select to complete the operation or Cancel to abort it. If the selected Functional Unit
is already a constituent of the Functional Unit, SEED-Layout displays an error message and
abort the operation.

6.3 View Menu

The options in this menu allow you to open the three attribute fields, which you can
open/close using the arrow buttons at the right-hand end of the respective title bars.

6.3.1 Occupancy

This option opens the Occupancy field. The attributes in this field are currently not us
SEED-Layout because they are important only for evaluation software or down-str
processes like structural design.

6.3.2 Constituents

This option opens the Constituents field.

6.3.3 Value Constraint

This option opens the value constraints field.

6.4 Occupancy Field

The attributes in this field are currently not used in SEED-Layout because they
important only for evaluation software or down-stream processes like structural de
that are currently not accessible from SEED-Layout.
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6.5 Constituents Field

The Constituents field displays the Constituents of the Functional Unit. Selecting one
and clicking the right mouse button opens another Functional Unit Window that all
you to inspect and modify the current settings of this Constituent.

6.6 Value Constraints Field

You may inspect the current settings and edit them. The following table indicates
meaning of each setting. Consult theSEED - Fundamental Conceptsmanual for a more
detailed explanation of the settings. Click the COMMIT button when you are done or
CANCEL button to return to the previous settings.

The following table shows the value constraints handled by SEED-Layout for varia
size Functional Units.

The next table shows the constraints handled by SEED-Layout for fixed-size Funct
Units.

Long Side:

Short Side:

Height:

Access side: Short side Long side Arbitrary

Elevation:

min max

X: lower bound for x-coordinate upper bound for x-coordinate

Y: lower bound for y-coordinate upper bound for y-coordinate

Width: minimum width of unit maximum width of unit

Area: minimum area of unit maximum area of unit

Aspect: 0 - no aspect ratio defined
positive value - aspect ratio to be
maintained

Height: minimum floor to ceiling height of unit maximum floor-to-ceiling height of
unit

Elevation: defined only for storeys (floors):
elevation above project zero elevation

Floor Depth
Above

defined only for storeys (floors):
assumed depth of floor slab above
41
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7 Layout Problem Manager

The Layout Problem Manager is a window that you can open under the Window men
the Design Window. Figure 20 shows an example.

7.1 File Menu

7.1.1 Refresh

<to be added>

7.1.2 Close

This option closes the Layout Problem Manager.

7.2 Problem Menu

7.2.1 Activate

Selecting this option activates the Layout Problem selected in the display field. SE
Layout updates the Design Window to display the last active Layout in the assoc
Design Space.

7.2.2 Remove

The remove option is currently not implemented.

7.3 Display Field

This field displays all Layout Problems that have been active so far in the current De
Space. You may select a Layout Problem to highlight it. Clicking the right mouse bu
opens a pop-up menu that allows you to activate the problem. The remove optio
currently not implemented.

menu bar

display field

FIGURE 20. Layout Problem Manager
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8 Constituent Hierarchy Window

Figure 21 shows a snapshot of the Constituent Hierarchy window. You can open
window by selecting the Constituent Hierarchy option under the Window menu in
Design Window. The window displays the Constituents of the top Functional Unit in
active Layout Problem through all lower levels. Each Constituent is shown as the nod
a tree whose links indicate the Constituent relations that define the hierarchy.

8.1 Edit a Functional Unit

Selecting a Constituent in the display area of the Constituent Hierarchy Window
clicking the right mouse button opens a pop-up menu whose options allow you to edi
Functional Unit.

The following three options are currently implemented.

FIGURE 21. Constituent Hierarchy Window

FIGURE 22. Edit Functional Unit menu
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8.1.1 Open

This option opens the Functional Unit Window, which you can use to inspect and mo
the current settings (see Section 6 on page 38).

8.1.2 Add Constituent

This option opens the Add Constituent Window, which you can use to add a Constitue
theselected Functional Unit.

For every Functional Unit added, you must select a class from the following options:

• Functional Unit (default, but not recommended)

• Storey (or Floor)

• Flat roof

• Sloped roof

• Building

• Massing element

• Horizontal zone

• Room

• Shaft

• Atrium

You must also select a type from the following options:

• variable size (default)

• fixed size.

Consult theSEED-Fundamental Concepts manual for an explanation of these options.

Steps:
1. Enter the name into the Name field.

2. Select the class of the Constituent in the Class pop-up menu.

3. Select the type in the Type pop-up menu.

4. Click Commit to confirm the action or Cancel to cancel.

8.1.3 Add Constituent from FU Library

Steps:
1. Selecting this option opens the Add Constituent file dialog box that displays the currently

saved Functional Units. These include - at the minimum - an instance for each available
Functional Unit class.

2. Select a desired Functional Unit (see Section 4 on page 25).

FIGURE 23. Add Constituent Window
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(Optional) Inspect and possibly modify the value constraints associated with this new
Constituent (see Section 6.5 on page 41). .

8.2 File Menu

8.2.1 Refresh

<to be added>

8.2.2 Close

This option closes the Constituent Hierarchy Window.

8.3 Layout Menu

This menu allows you to change the display of the Constituent hierarchy.

8.3.1 LeftRight

The tree is shown with its nodes arranged from left to right.

8.3.2 TopDown

The tree is shown with its nodes arranged from top to button (as in Figure 21).

8.3.3 Indented

The tree is shown with its nodes arranged from top to button with indentations indica
the different levels.
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9 Layout Tree Window

Figure 24 shows a snapshot of the Layout Tree Window. It displays all Layouts that
been generated for the active Layout Problem. The window represents each Layou
node and shows explicitly the parent/child relations between Layout s. The curre
active Layout is indicated by a tick box.

You may open the Layout Tree Window by selecting the Layout Tree option under
Window menu in the Design Window.

9.1 File Menu

9.1.1 Refresh

<to be added>

9.1.2 Close

This option closes the Layout Tree Window.

9.2 Layout Menu

This menu allows you to change the display of the Layout tree.

9.2.1 LeftRight

The tree is shown with its nodes arranged from left to right (as in Figure 24).

9.2.2 TopDown

The tree is shown with its nodes arranged from top to button.

FIGURE 24. Layout Tree
Window
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9.2.3 Indented

The tree is shown with its nodes arranged from top to button with indentations indica
the different levels.
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10 Evaluation Result Window

The Evaluation Result Window reports the results of evaluating the active Layout aga
the constraints associated with the Functional Units allocated in it. Use the scroll bar
navigate through the report (see Figure 25).

Note that the evaluation results of successive active Layouts accumulate in the windo
you want to reduce its size, select the Clear option in the Tool menu. The Close opti
the Tool menu closes the window.

FIGURE 25. Evaluation Result Window
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Appendix A

This appendix describes the format for files containing the specification of a Lay
Problem that can be loaded into SEED-Layout. Any program that is able to generate
of this form may serve as front-end to SEED-Layout. The file parser itself has b
generated from a high-level grammar specification using the UNIX programming tools

and yacc1.

The file format is defined below in terms of a context-free grammar in BNF notation2. The
only terminal symbols in the grammar are keywords, which are uniformly made up
upper case alphabetic characters and, possibly, underscores. Non-terminal symbols
grammar are indicated by lower case characters and, possibly, the underscore cha
and angular brackets. Non-terminal symbols that are enclosed in brackets expand
sequences of symbols. Non-terminal symbols not enclosed in brackets represent cha
sequences that will be interpreted as single strings or numbers.

A Layout Problem specification is recursively defined as a list of “speclines” of arbitr
length:

<specification>  <specline> | <specification> <specline>

A <specline>  must belong to one of the following six types:

<specline>  <context_spec>
| <units_spec>
| <fu_spec>
| <valconstraint_spec>
| <relconstraint_spec>
| <constituent_spec>

A context specification,<context_spec> , restricts the overall area available for laying
out the Functional Units in the Layout Problem. It may take one of the following form

<context_spec>  CONTEXT X_LO_MIN number
| CONTEXT X_LO_MAX number
| CONTEXT X_HI_MIN number
| CONTEXT X_HI_MAX number
| CONTEXT Y_LO_MIN number
| CONTEXT Y_LO_MAX number
| CONTEXT Y_HI_MIN number
| CONTEXT Y_HI_MAX number

The keywordCONTEXT indicates that the specification under consideration is a cont
specification. The next keyword indicates which context variable is being specifi
number  must be a real or integer number.

Example:CONTEXT X_HI_MAX 180.00

1. J. R. Levine; T. Mason; D. Brown:lex & yacc (2nd ed.) O’Reilly &Ass., Sebastopol, CA (1992)

2. A. V. Aho; R. Sethi; J. D. Ullman:Compilers. Addison-Wesley, Reading, MA (1988) ch. 2

→

→

→
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The example context specification restricts the overall extent in the x-direction to
coordinate 180. Note that the parser does not check for consistency between diff
context specifications. SEED-Layout’s constraint solver does this when it tries to gen
an initial layout for the Layout Problem defined in an open file.

A unit specification identifies the units of measurement used in the present La
Problem. It has the following form:

<units_spec>  UNITS unit

whereunit must be one of the following one- or two-character strings:mm, cm, m,
in, ft . The units have the obvious meaning.

Example:UNITS ft

A Functional Unit specification,<fu_spec> , defines a Functional Unit and can have on
of the following forms:

<fu_spec>  FU fu_id fu_class fu_name
| TOP_FU fu_id fu_class fu_name

fu_class   BUILDING
| MASS_ELEMENT
| SHAFT
| ATRIUM
| FLOOR
| FLAT_ROOF
| SLOPED_ROOF
| HORIZ_ZONE
| ROOM
| FUNCTIONAL_UNIT

The first specline must be used to define Functional Unit constituents and the seco
define the top Functional Unit of the Layout Problem.

Example:TOP_FU ae2e88 BUILDING “Maintenance facility”

fu_id is a unique string consisting of alphanumeric characters only. When SEED-La
generates a Layout Problem file, it uses the pointer values of the respective Func
Unit objects as identifiers, which are hexadecimal numbers. But the parser reads
identifiers as strings so that any other alphanumeric string will do as long as it is uni
Whenever the file parser encounters such anfu_id in a specline, it compares it with the
entries in a symbol table; if the entry exists, the parser attaches the specification t
corresponding Functional Unit; otherwise, it creates a new entry and associates wit
new Functional Unit. In this way, multiple references to the same Functional Uni
different speclines can be properly interpreted.

fu_class is a character string indicating the class of the Functional Unit. Use of
FUNCTIONAL_UNIT class is discouraged because this is essentially an abstract cla

fu_name is the name of the Functional Unit as it appears in the display of floor plans
can have one of two forms:

→

→

→
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• a string consisting solely of alphanumeric characters and, possibly, the undersco
character

• a string enclosed in double quotes, where any character can appear between th
quotes except for the double quote itself and the newline character.

A value constraint specification,<valconstraint_spec>, specifies a value
constraint for the Functional Unit indicated byfu_id . It has one of the following forms:

<valconstraint_spec>  MIN_WIDTH fu_id number
| MAX_WIDTH fu_id number
| MIN_AREA fu_id number
| MAX_AREA fu_id number
| ASPECT fu_id number
| SHORT_SIDE fu_id number
| LONG_SIDE fu_id number
| FRONT_LONG fu_id number
| X_LOW fu_id number
| Y_LOW fu_id number
| X_HIGH fu_id number
| Y_HIGH fu_id number
| HEIGHT fu_id number
| ELEVATION fu_id number

The example specline below defines a min. area constraint of 1500 (in the units spe
by a units specification) for the Functional Unit with ida34928.

Example:MIN_AREA a34928 1500

In general, theMIN_AREA, MAX_AREA, MIN_WIDTH, MAX_WIDTHand ASPECT
keywords specify value constraints for variable-size Functional Units. T
SHORT_SIDE, LONG_SIDE andFRONT_LONGkeywords specify value constraints
for fixed-size Functional Units. AHEIGHTspecification can be given for any Functiona
Unit. TheELEVATION specification is processed only for buildings and floors.

The parser checks only if the numerical constraint parameter in a value constraint spe
is in the allowable range; that is,number must be always positive, except fo
ELEVATION, where it can also be zero or negative (depending on where the project o
has been placed), and forFRONT_LONG, where it must be the integer 0 or 1. The pars
does not check for consistency between individual value constraints; it leaves this t
constraint solver during allocation.

A relational constraint specification,<relconstraint_spec> , can have one of the
following forms:

<relconstraint_spec>  ADJACENCY fu-ref fu_ref number
| ACCESS fu_ref fu_ref number
| DISTANCE fu_ref fu_ref number
| DIRECTION fu_ref fu_ref number number number number
| ALTERNATIVE ad_id fu_ref fu_ref number

fu_ref fu_id
|   OUTSIDE

→

→

→
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The example below specifies that the Functional Unit with ida2d8c8 must be adjacent
to the outside with a minimum overlap of 12 units:

Example:ADJACENCY a2d8c8 OUTSIDE 12

If both fu_ref s are fu_id s, the respective relation is established between
corresponding Functional Units. If onefu_ref is the string OUTSIDE in a relational
constraint specification, the otherfu_ref must be anfu_id  for obvious reasons.

The parser checks if thenumber parameters are positive except for theDIRECTION
constraint, in which case eachnumber must be a binary integer; the four number
indicate if a direction is desired (1) or not (0) in the following order: N, E, S, W.

The ALTERNATIVE specline can be used to specify an individual alternative in
alternative adjacency constraint.ad_id is a unique indentifier of the alternative
adjacency constraint. It has the same form as and functions like anfu_id in that it
defines an entry in a symbol table and is used to link individual alternatives to the pr
constraint: When the parser encounters anad_id in an ALTERNATIVE specline, it
checks if that id exists in the symbol table; if so, it links the alternative to the constr
with that id; otherwise, it creates a new alternative adjacency constraint with that id
enters it into the symbol table before linking the alternative to it.

A constituent specification has the following form:

<constituent_spec>  CONSTITUENT fu_id fu_id

The first fu_id identifies the Functional Unit that has the Functional Unit with th
secondfu_id as a constituent. At the end of the parse, SEED-Layout checks if ev
Functional Units that has been defined is in fact a constituents of another Functio
Units, except for the top unit. If it finds Functional Units that do not meet this condition
flags them as ’orphan’ units.

Lines that start with the ‘#’ character are treated as comment lines until the new
character is encountered.Thefirst line of thefile mustbea commentline startingwith the
string

#SLayout_Problem

Thefile extensionmustbe’.lp’. The Load command uses this extension and the initial lin
to determine if the file selected by the user is of the proper form. After this opening l
comment lines can appear anywhere in the file and are ignored by the parser.

A specline does not have to end with the newline character. However, it is good practi
do this. It increases the readability of the file, and - more importantly - it provid
convenient resynchronization points for the parser when it tries to recover after a sy
error has been encountered; in this case, the parser ignores the current specline that
be properly parsed, prints an error message, and restarts parsing after the next n
character. The information in the corrupted specline will not be processed; that is
corresponding specification will not be set in the Layout Problem.

The order of the speclines in a Layout Problem file is almost arbitrary. For example,
may assign a constituent relation between Functional Units before either one has
defined by anFU or TOP_FUspecline, that is, before the class of either Functional U
or its name are known. In this case, the parser creates temporary Functional Units wi

→
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proper identifiers and adds specifications to each until it encounters a definition spe
that indicates the correct class and name, at which time it replaces the temp
Functional Unit with the desired one under the same id; it also transfers all v
constraints and constituent relations that have been collected so far for the temp
Functional Unit to this new version.

There is one exception to this: theELEVATIONconstraint cannot be set for aFLOORor
BUILDING before thatFLOORor BUILDING has been defined by anFU or TOP_FU
specline. The reason is thatFLOORsandBUILDINGs are the only Functional Units for
which theELEVATION constraint can be set. All other Functional Units receive the
elevation in a layout from theFLOORor BUILDING to which they belong. We decided to
limit the ELEVATION constraint in this way to make it easier for SEED-Layout
maintain consistency between the elevations of all pieces in a layout, not only wh
constituent hierarchy is set up, but also when costituents are moved between floors.
pitch constraints are implemented for roofs, a similar restriction will hold for t
definition of roofs and pitch constraints. In general,it is good practice to define a
Functional Unit before any of its attributes is set.

Since the parser is able to recover from errors, it usually creates a Layout Problem t
largely correct. SEED-Layout subsequently attempts to create a design space and an
layout in that space. It fails to do this only if the following essential parts of a Layo
Problem have not been given:

• a top Functional Unit

• at least one constituent of the top Functional Unit

• the X_HI_MAX  andY_HI_MAX context specifications.

SEED-Layout needs these pieces of information because it has to know the maxi
extent of the available area and what to allocate in it. Figure 26 shows portions
complete Layout Problem file that illustrate aspects of the present grammar.
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#SLayout_Problem
CONTEXT X_LO_MIN 0.00
CONTEXT X_HI_MAX 180.00
CONTEXT Y_LO_MIN 0.00
CONTEXT Y_HI_MAX 50.00
UNITS ft
TOP_FU 72d928 BUILDING Firestation
MIN_WIDTH 72d928 50.00
MIN_AREA 72d928 4400.00
HEIGHT 72d928 15.00
FU 72dab8 MASS_ELEMENT appr
SHORT_SIDE 72dab8 40.00
LONG_SIDE 72dab8 50.00
FRONT_LONG 72dab8 0
HEIGHT 72dab8 15.00
CONSTITUENT 72d928 72dab8
FU 72dbb8 SLOPED_ROOF appr_roof
ELEVATION 72dbb8 15.00
...
CONSTITUENT 72dab8 72dbb8
FU 72de78 FLOOR appr_floor
ELEVATION 72de78 0.00
...
CONSTITUENT 72dab8 72de78
FUu 72e1b8 MASS_ELEMENT “Adm. Wing”
...
Y_LOW 72e1b8 10.00
...
FU 72e2f0 FLOOR Admw_1f
...
CONSTITUENT 72e1b8 72e2f0
...
ADJACENCY 72dab8 72e1b8 12.00
DIRECTION 72dab8 72e1b8 0 1 0 1
. . .

FIGURE 26. Sample Layout Problem file
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